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본 문서는 모피어스 IDE의 구성, 기능에 대해 기술하며, 모피어스 IDE 에 대한 소개 자료로 활용 될 수 

있습니다. 

 

1. 모피어스 IDE(Intergrated Development Environment) 개요 

모피어스 플랫폼을 사용하기 위한, 통합 개발 환경을 의미 합니다. IDE에서는 개발 환경 설정, 

프로젝트 생성, 코딩, 컴파일, 실행, 디버깅, Export 기능을 지원합니다. 

 

1.1. 구성 

1. IDE 는 Eclipse Plug-In 기반으로 개발되었으며, Eclipse 와 동일한 형태의 개발 환경을 제공합니다. 

2, 기본 메뉴는 Morpheus | File | Edit | Navigate | Search | Project | Run | Windows | Help 로 구성 됩니다. 

 

1.2. 실행환경 

1. 권장 OS : Windwos XP 이상, mac os x 10.7(64bit) 이상 - 버전에 맞는 실행 파일을 다운로드 받아 

설치 해야 합니다. 

2. JAVA 버전 : 1.7 이상  

 

1.3. IDE 문의 

1. www.morpheus.co.kr 기술지원 게시판 
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2. 소프트웨어 설치 

2.1. JDK 설치 

2.1.1. Windows 용 

1. JDK(Java Developer's Kit) 설치 

 

 

그림 2-1 Java 설치 

Java 홈페이지에서 (http://www.oracle.com/) 자신의 OS 환경에 맞는 Java 설치 파일을 

다운로드 받아 설치합니다 

 

2. 시스템 환경변수 설정 

시작 메뉴를 클릭하여 환경변수를 검색하면 그림 2-2 와 같이 계정의 환경변수 편집 메뉴가 

검색됩니다. 

 

그림 2-2 환경변수 메뉴 찾기 

또는 환경 변수(N)를 설정하는 창은 위와 같은 방법으로 간단히 접근하거나, '내 컴퓨터' 우 

클릭 후 속성 또는 '윈도우 키 + Pause/Break 키'를 통해 들어간 시스템 창의 고급 탭 하단의 

환경 변수 버튼을 클릭합니다. 
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그림 2-3 환경변수 메뉴 찾기(2) 

윈도우에 설치된 Java 설치 경로를 확인합니다. Java 를 설치할 때 경로를 수정하지 않았다면 

보통 C:\Program Files\Java 에 설치되게 됩니다. 

 

그림 2-4 JAVA_HOME 추가 

그림 2-4 와 같이 환경변수 창에 하단 새로 만들기 버튼을 누르고 아래와 같은 값을 입력한 

후 확인 버튼을 누릅니다. 

 변수 이름(N): JAVA_HOME 

 변수 값(V): Java 설치 경로 
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그림 2-5 와 같이 시스템 변수 리스트에서 Path 항목을 찾아 선택한 후 편집 버튼을 

누릅니다. 

 

그림 2-5 Path 추가 

변수 값(V)의 마지막에 세미콜론(;)을 붙여준 뒤 %JAVA_HOME%\bin 을 추가로 

붙여줍니다. 

다음으로 그림 2-6 과 같이 CLASSPATH 항목을 찾아 편집 버튼을 누르고 위에서와 

마찬가지로 변수 값(V) 마지막에 세미콜론(;)을 붙여준 뒤 %JAVA_HOME%\lib\tools.jar 을 

추가로 붙여줍니다. 
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그림 2-6 ClASSPATH 추가 

윈도우의 커맨드 창을 열어서 java 혹은 javac 라고 쳤을 때 반응이 있으면 Java 설정이 

정상적으로 완료된 것입니다. 

 

그림 2-7 Java 설치 확인 

 

2.1.2. Mac 용 

 

그림 2-8 Java 설치 또는 업데이트 
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MAC OS는 기본적으로 JAVA가 설치되어 있습니다. 현재 OS 버전에 맞게 SE 업데이트 합니다. 

 

 

 

2.2. 안드로이드 SDK 설치 

 

그림 2-9 안드로이드 SDK 다운로드 
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안드로이드 개발자 홈페이지에서 안드로이드 SDK 실행파일을 다운로드 받을 수 있습니다. 

(http://developer.android.com/sdk/index.html

 

그림 2-10 안드로이드 SDK 라이선스 동의 

 라이선스 동의와 개발 컴퓨터 환경을 선택 후 다운로드 버튼을 클릭합니다. 다운받은 파일의 압축을 

풀면 아래와 같이 eclipse, sdk, SDK Manager 가 생성 됩니다.SDK Manager 를 더블 클릭하여 

실행합니다.  
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2.2.1. 안드로이드 버전별 플랫폼 다운로드 

 

그림 2-11 안드로이드 플랫폼 다운로드 

Android SDK Manager 를 이용하여 필요한 버전의 플랫폼을 다운로드 받아야 합니다. 기본적인 

Android Tools 은 설치되어 있으며 상황에 따라 Android SDK Build-tools 을 업그레이드 및 

다운그레이드를 할 수 있습니다. 

 

2.3. Xcode 설치 

아이폰 프로그래밍을 하기 위해선 필요한 것 중의 하나가 Xcode라고 불리는 애플리케이션 제작 

툴입니다. Eclipse, Visual Studio, J빌더 와 같은 개발도구이며 Xcode는 개발자들에게 간결하고 쉽게 

프로그래밍 할 수 있도록 다양한 방법을 제공 합니다. Xcode는 Apple App Store에서 무료 다운받아 

설치할 수 있습니다. 
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그림 2-12 Xcode 설치 
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3. IDE 

3.1. 모피어스 IDE 시작 

Morpheus IDE는 모피어스앱을 개발하기 위한 도구로 모피어스 프래임워크에서 제공하는 기능을 

쉽고 빠르게 적용하고 개발하기 위한 도구 입니다. 실행 파일을 더블 클릭하여 프로그램을 실행시키면 

그림 3-1 과 같은 로그를 볼 수 있으며, 프로그램 로딩 진행상황을 나타내는 진행 바가 나타나고 

모피어스 IDE가 실행 됩니다. 

 

그림 3-1 Workspace 설정 

실행 후 첫 번째로 나타나는 화면은 모피어스 IDE를 통해 생성되는 프로젝트들을 저장할 작업 공간을 

선택하는 화면입니다. 프로젝트를 저장할 작업공간을 선택하고, OK 버튼을 누르면 아래와 같은 초기 

화면이 나타납니다. 
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그림 3-2 IDE 초기화면 

모피어스 IDE 상단 메뉴모음에는 모피어스 라이브러리를 관리하는 리소스 매니저 호출 버튼이 있고 

도구 왼쪽에는 프로젝트 리소스들을 관리할 수 있는 기능이 있습니다. 도구 중앙에 위치한 편집기 

영역에는 파일의 특성에 맞는 에디터가 열리게 됩니다. 중앙 에디터 영역 아래엔 에디터 기능을 

보조하는 기능들이 위치해 있습니다. 

 

그림 3-3 퍼스팩티브 지정 
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만약 도구 실행 후 위와 같은 레이아웃이 아닐 경우 도구 메뉴 중 Window → Open Perspective  

→ Other를 선택한 후 Morpheus Mobile 항목을 선택하면  위와 같은 화면으로 재구성 됩니다. 

 

3.2. 리소스 매니저 

  모피어스 IDE를 이용하여 모피어스 앱을 개발하기에 앞서 개발에 필요한 파일들을 리소스 매니저를 

통해 설치해야 합니다. 리소스 매니저를 통해 개발에 필요한 파일들을 설치, 삭제, 업데이트 할 수 

있습니다.  

 

그림 3-4 툴바 메뉴 

도구 상단 메뉴 중 리소스 매니저 열기 버튼을 클릭하면 리소스 매니저 대화상자가 그림 3-5 와 

같이 나오게 됩니다. 

 

그림 3-5 리소스 매니저 

리소스 매니저 왼쪽에는 설치 항목들이 트리 구조로 나열되고 여기서 선택되는 아이템에 대한 설명이 

오른쪽 화면에 나오게 됩니다.  각 항목들에 대한 설치 상태를 보고 설치할 항목들을 선택합니다. 

설치가 되어있지 않을 경우 미 설치로 상태 값이 표기되며, 설치된 파일들 중 업데이트된 항목이 있을 

경우 업데이트를 받을 수 있습니다. 리소스 매니저의 각 기능들은 다음과 같습니다. 

 

 목록 업데이트 : 서버에서 최신목록을 받아와 화면에 표시 합니다. 

 전체 선택해제 : 선택된 아이템을 해제 합니다. 

 리소스 설치 : 선택된 파일을 설치합니다. 

 리소스 삭제 : 선택된 파일을 삭제합니다. 

 리소스 가져오기 : 네트워크에 연결되지 않아 서버에서 직접 파일들을 설치하기가 어려운 
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경우 이용하게 됩니다. 압축파일 형태의 리소스를 선택하여 설치하게 됩니다. 

 리소스 내보내기 : 현재 설치되어 있는 리소스를 압축파일 형태로 배포합니다.  

 

리소스 매니저에 나오는 항목들은 모두 개발에 필요한 파일들이므로 모두 설치 후 개발 시작하는 

것을 권장합니다.  

 

 

3.3. 모피어스 프로젝트 

3.3.1. 프로젝트 생성 

Morpheus Application Project Wizard를 통해 신규 프로젝트를 생성 하게 됩니다. Morpheus 

Application Project Wizard를 호출 하는 방법은 다음과 같습니다. 

 상단 메뉴 중 File → New → Morpheus Application Project 선택  

 마우스 오른쪽 버튼 → New → Morpheus Application Project 선택  

 메뉴 바 New 아이콘 → Morpheus Application Project 선택  

 

그림 3-6 프로젝트 생성 위자드 첫번째 페이지 

프로젝트를 생성하고 프로젝트 기본 정보를 입력하는 첫 번째 페이지가 호출 됩니다. 각 입력 
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항목들에 대한 설명은 다음과 같습니다. 

 

 프로젝트 이름 : 프로젝트 이름을 입력합니다. 

 라이선스 정보 : 앱에 적용할 라이선스를 선택합니다. 만약 라이선스가 없을 경우 교육용 

라이선스를 선택하여 앱을 생성할 수 있고 발급받은 라이선스가 존재한다면 추가하기 버튼을 

눌러 라이선스를 추가한 후 선택 할 수 있습니다. 라이선스가 선택되면 라이선스에서 정의하고 

있는 앱 아이디가 자동으로 안드로이드 패키지 이름, iOS 번들 아이디에 적용됩니다. 

 동일한 애플리케이션 정보 사용하기 : 애플리케이션 정보 중 동일한 애플리케이션 정보 사용하기 

선택 시에는 Android, iOS 서로 동일한  애플리케이션 이름을 사용합니다. 

 서로 다른 애플리케이션 정보 사용하기 : 애플리케이션 정보 중 서로 다른 애플리케이션 정보 

사용하기 선택 시에는 Android, iOS 각각 서로 다른 애플리케이션을 사용합니다 

 프로젝트 이름 : 프로젝트로 사용할 이름을 입력합니다. 

 애플리케이션 이름 : 애플리케이션 이름을 입력합니다. 기기에 설치되면, 표시되는 앱 이름입니다. 

 안드로이드 SDK 버전 : 안드로이드 SDK 버전 선택 : compile시 참조할 SDK 버전을 선택합니다. 

 안드로이드 패키지 아이디와 iOS 번들 아이디 는 Google play 와 App Store에서 앱을 등록하기 

위한 고유 식별자 입니다. Morpheus Manifest Editor의  overview 탭을 통해, 수정할 수 

있습니다.  

- 적용된 라이선스에 따라, 기능이 제한될 수 있습니다.  

 iOS Deployment Target : 배포할 iOS 버전을 선택합니다. 

 

첫 페이지에 입력할 정보들을 모두 입력했으면 하단의 Next 버튼이 활성화 됩니다. Next 버튼을 눌러 

다음단계로 넘어갑니다. 
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그림 3-7 프로젝트 생성 위자드 두번째 페이지 

그림 3-7 은 샘플로 제공하는 Template을 선택하는 화면입니다. 왼쪽에 위치한 프로젝트 항목을 

선택하면 생성하는 프로젝트에 선택한 템플릿이 적용됩니다. 중앙에 위치한 미리 보기 기능 상단에 

Page1, Page2 를 클릭하면 템플릿 프로젝트의 주요화면을 확인할 수 있습니다. 오른쪽에 위치한 

프로젝트 설명 영역에는 현재 선택된 템플릿 프로젝트에 대한 필수 라이브러리가 표시 돕니다. 만약 

템플릿 프로젝트가 보이지 않는다면 하단에 있는 리소스 매니저 열기 버튼을 클릭하여 최신 라이브러리 

및 에뮬레이터, 템플릿을 업데이트 하고, 설치할 수 있습니다. 프로젝트에 적용할 템플릿 프로젝트를 

선택했으면 Next 버튼을 눌러 다음단계로 넘어갑니다. 
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그림 3-8 프로젝트 생성 위자드 세번째 페이지 

다음은 그림 3-8 과 같은 프로젝트에 적용할 라이브러리를 선택하는 화면입니다. 코어 라이브러리 

API 버전 선택 항목은 제공되는 라이브러리의 버전을 선택하고, 애드온 라이브러리를 선택적으로 

사용할 수 있습니다. 애드온 라이브러리는 default가 전체 선택되어 있으며, 필요 시 해제 할 수도 

있으나 전체 선택하여 사용하는 것을 권장합니다. 플러그인 라이브러리는 플랫폼에서 제공하는 

플러그인 라이브러리가 표시되는 영역으로 Native 제어가 필요한 부분에 대해, 미리 Plug-In화 하여 

제공합니다. 플러그인이 필요한 사항은 게시판(컨설팅팀)을 통해 요청이 가능하며 플러그인 개발 여부 

및 개발일정은 자체 일정을 감안하여, 판단합니다. 늦어지는 경우, 프로젝트 조직에서 자체 개발이 

필요할 수 있습니다. 

만약 적용할 라이브러리가 없다면 하단 리소스 매니저 열기 버튼을 클릭하여 최신 라이브러리 및 

에뮬레이터, 템플릿을 업데이트 하고, 설치할 수 있습니다. 라이브러리를 모두 적용 했으면 Next 

버튼을 눌러 다음단계로 넘어갑니다. 
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그림 3-9 프로젝트 생성 위자드 네번째 페이지 

그림 3-9 는 앱에 적용될 부가정보를 설정하기 위한 페이지 입니다. 위에는 각 항목들을 입력할 수 

있게 되어있고 제목 링크를 클릭하면 선택한 항목에 대한 설명이 하단 설명 영역에 나타납니다. 각 

항목들에 대한 설명은 아래와 같습니다.  

 Log : 개발 시 콘솔창에서 모피어스 Log 를 보기 위해 설정 입니다. 

 Language : 기본 언어를 선택합니다. 

 Base Version : 다운로드 된 리소스를 관리하기 위한 버전입니다. 사용자가 마켓에서 앱을 

다운로드 후, 실행하면 기본 버전부터 최신 버전까지 리소스를 차례로 업데이트 하여, 최신 

버전으로 유지 시켜 줍니다. 

 Target : 리소스 다운로드 위치를 설정합니다. 서비스 시에는 “doc”를 권장합니다. 

▪ app : 앱 안에 포함된 리소스를 사용한다.(개발 및 리소스 업데이트를 사용하지 않는경우 사용)  

▪ doc : 앱에 할당된 read/write 가 가능한 공간에 있는 리소스를 사용한다.(리소스 업데이트와 

리소스 복사 기능을 이용하여 배포하는 경우 사용)  

▪ sdcard : sdcard 영역에 포함된 리소스를 사용한다.(개발시 사용) - 지원 OS : Android  

OS 정책에 따라, 지원이 제한될 수 있습니다. 

 Start Page Name : 앱 실행 후, 가장 먼저 호출하는 Page 입니다. 

 Start Page Orientation : 앱 실행 시, 초기 화면의 방향을 지정합니다. 

 Start Page Orientation(Tablet) : 앱이 실행되는 단말기가 태블릿인 경우 앱 실행 시, 초기 
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화면의 방향을 지정합니다. 

 Default Orientations : 앱의 기본 회전 방향을 선택합니다. 

 Default Orientations(Tablet) : 앱이 실행되는 단말기가 태블릿인 경우 앱의 기본 회전방향을 

선택합니다. 

 Default Animation : 앱의 화면 전환 시 기본 Animation 을 선택합니다. 

 Default Indicator : 화면 전환 및 통신으로 인한 Indicator 표시 여부를 선택합니다. 

 Hardware Acceleration : 안드로이드 하드웨어 가속 기능 사용 유무를 선택합니다. 

 Theme : 안드로이드 Theme 사용 유무를 선택합니다. 

모든 설정이 끝난 후 Finish 버튼을 누르면 설정정보를 반영한 프로젝트가 생성됩니다. 

 

3.3.2. 프로젝트 구조 

  모피어스 프로젝트는 모피어스 앱을 만들기 위한 파일 구조로  Android,  iOS 리소스 + 모피어스 

프래임워크 파일 + 화면을 구성하는 HTML, Javascript 파일로 구성됩니다. Morpheus Application 

Project Wizard를 통해 프로젝트가 생성되면 그림 3-10 과 같이 IDE 왼쪽에 위치한 Project 

Explorer에서 프로젝트를 확인할 수 있습니다.  

 

그림 3-10 프로젝트 구조 

프로젝트 트리를 열어보면 위 그림과 같은 구조를 확인할 수 있습니다. 각 파일들은 다음과 같은 

역할을 합니다. 

 M-Core : 프로젝트에 적용된 모피어스 라이브러리들을 확인 할 수 있습니다. 

 Android x.x : 프로젝트에 적용된 안드로이드 SDK 라이브러리를 확인할 수 있습니다. 

 Android Private Libraries : 안드로이드 프로젝트에 적용된 JAVA 라이브러리들을 확인할 수 

있습니다. 

 src : 안드로이드 Java 소스파일이 위치해 있습니다. 이곳에서 안드로이드 Native Source를 

수정할 수 있습니다. 
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 gen : 안드로이드 리소스를 자동관리하는 R.java 파일이 위치하게 됩니다. 

 assets : 화면을 구성하는 HTML, Javascript, img, js 파일이 위치하게 됩니다. 

 

그림 3-11 assets 

assets 폴더를 열어서 내부를 살펴보면 위 그림과 같습니다. res 폴더 안으로 www 폴더가 

있고 그 안에 프로젝트 생성과정에서 선택한 템플릿 화면을 구성하는 HTML 구성요소들이 

폴더로 구분되어 들어가 있습니다. 그 밑으로 모피어스 앱 설정정보를 담고있는  Manifest.xml 

파일과 라이선스 정보가 있는 mcore.mobile.lic 파일이 있습니다.  모피어스앱 화면 구성을 

위해 대부분의 작업을 이 폴더 내부에서 하게 될 것 입니다. 

 bin : 빌드 과정에서 생성되는 파일들이 저장됩니다. 

 libs : 안드로이드 Java 라이브러리 파일을 추가하는 폴더 입니다. 

 native : iOS 앱을 위한 프로젝트 파일이 위치해 있습니다.  

(주의)iOS Native Source 수정은 xcode를 통해 지원하고 있습니다. 

 res : 안드로이드 리소스들을 저장하는 위치 입니다. 

 AndroidManifest.xml : 안드로이드 앱 설정 정보를 담고있는 Manifest 파일입니다. 

 application.xml : 모피어스 프로젝트 설정 정보를 담고있는 파일입니다. 

 기타 파일 : 프로젝트 빌드 설정 정보를 담고있습니다. 
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3.4. Morpheus Application Editor 

Morpheus Application Editor는 개요, Manifest, 라이브러리 매니저, Manifest.xml 탭으로 구성되며 

모피어스 앱의 기본 정보 및 각종 설정 정보를 확인하고 변경할 수 있습니다.  Morpheus Application 

Editor는 프로젝트 생성과 동시에 열리게 되며, Project Explorer에서 프로젝트 내부에 있는 

application.xml 파일이나 assets/res/www/Manifest.xml 파일을 더블 클릭하여 열 수 있습니다. 

Morpheus Application Editor에서 설정 정보를 변경한 후에는 Ctrl + S(Mac : command + S) 버튼을 

눌러 변경 내용을 저장 할 수 있습니다.  

 

3.4.1. 개요 

 

그림 3-12 개요 

개요 탭에서는 앱의 기본정보를 설정하고 실행과 배포를 할 수 있는 링크들을 제공합니다. 각 그룹별 

기능은 다음과 같습니다. 

 프로젝트 기본정보 

▪ 프로젝트 이름 : 해당 프로젝트 이름입니다. 

▪ 라이선스 상태 : 라이선스 적용 유무를 나타냅니다. 라이선스를 변경해야 할 경우 

변경하기 버튼을 이용해 라이선스를 변경할 수 있습니다.  
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그림 3-13 라이선스 변경 

변경할 라이선스를 선택하게 되면 그림 3-13 과 같은 대화상자가 나타나는데 

라이선스에 등록되어 있는 애플리케이션 아이디로 변경을 선택할 경우 안드로이드 

패키지 이름과 iOS 번들 아이디를 입력 창이 나타나고 입력된 정보가 자동으로 

변경됩니다. 

 Android 프로젝트 기본정보 

▪ 애플리케이션 이름 : 안드로이드 단말기에 설치될 때 보여지게 될 이름입니다. 

▪ 안드로이드 패키지 이름 : 안드로이드 프로젝트 고유 ID값 입니다. 

 iOS 프로젝트 기본정보  

▪ 애플리케이션 이름 : iOS 단말기에 설치되고 보여지게 될 이름입니다. 

▪ Bundle Identifier : iOS 프로젝트 고유 ID값 입니다. 

 설정 페이지들 

▪ Manifest : Manifest 탭으로 이동합니다. 

▪ 라이브러리 매니저 : 라이브러리 매니저 탭으로 이동합니다. 

 실행 / 배포 

▪ 실행하기 

• 안드로이드 디바이스/에뮬레이터에서 모피어스 애플리케이션을 실행 합니다. 

• 아이폰 디바이스/시뮬레이터에서 모피어스 애플리케이션을 실행합니다. 

• 브라우저 에뮬레이터에서 모피어스 애플리케이션을 실행 합니다. 

▪ 배포하기 

• 모피어스 애플리케이션을 안드로이드 패키지로(APK) 배포합니다. 

• 모피어스 애플리케이션을 iOS 패키지로(IPA) 배포합니다. 

• 모피어스 애플리케이션 프로젝트를 압축파일(Zip)으로 배포합니다. 

• 모피어스 애플리케이션 프로젝트 리소스를 압축파일(Zip)로 배포합니다. 

▪ 프로젝트들 

• 모피어스 iOS 프로젝트를 Xcode 로 엽니다. 
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3.4.2. Manifest 

 

그림 3-14 Manifest 

Manifest 탭에서는 앱 관련 설정들을 합니다. 왼쪽에 설정 항목들이 있고 항목을 클릭하면 오른쪽 

설명 영역에 선택한 항목에 대한 설명을 확인할 수 있습니다. 

 기본설정 

▪ Log : 개발 시 콘솔 창에서 Log 를 보기 위해 설정 입니다. 

▪ Language : 기본 언어를 선택합니다. 

▪ Base Version : 다운로드 된 리소스를 관리하기 위한 버전입니다. 사용자가 마켓에서 

앱을 다운로드 후, 실행하면 기본 버전부터 최신 버전까지 리소스를 차례로 업데이트 

하여, 최신 버전으로 유지 시켜 줍니다. 

▪ Target : 리소스 다운로드 위치를 설정합니다. 서비스 시에는 “doc”를 권장합니다. 

 app : 앱 안에 포함된 리소스를 사용한다.(개발 및 리소스 업데이트를 사용하지 

않는경우 사용)  

 doc : 앱에 할당된 read/write 가 가능한 공간에 있는 리소스를 사용한다.(리소스 

업데이트와 리소스 복사 기능을 이용하여 배포하는 경우 사용)  

 sdcard : sdcard 영역에 포함된 리소스를 사용한다.(개발 시 사용) - 지원 OS : 

Android 

 sdcard 사용은 os 버전에 따라, 기능이 제한될 수 있으므로, 권장하지 않음  

▪ Start Page Name : 앱 실행 후, 가장 먼저 호출하는 Page 입니다. 

▪ Start Page Orientation : 앱 실행 시, 초기 화면의 방향을 지정합니다. 

▪ Start Page Orientation(Tablet) : 앱이 실행되는 단말기가 태블릿인 경우 앱 실행 시, 

초기 화면의 방향을 지정합니다. 
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▪ DirectView  : UI / Script 수정 후, 단말기에 컴파일시 소요 되는 시간을 단축하기 위해 

IDE 내부의 로컬웹서버를 통해 데이터를 호출 할 수 있도록 하는 기능입니다.   

주의) 해당 기능을 사용하기 위해서는 동일한 네트워크상에 있어야 합니다. 즉, 

IDE환경의  PC와 단말기가 같은 와이파이 망에 접속되어 있어야 합니다. 

▪ Default Orientations : 앱의 기본 회전 방향을 선택합니다. 

▪ Default Orientations(Tablet) : 앱이 실행되는 단말기가 태블릿인 경우 앱의 기본 

회전방향을 선택합니다. 

▪ Default Animation : 앱의 화면 전환 시 기본 Animation 을 선택합니다. 

▪ Default Indicator : 화면 전환 및 통신으로 인한 Indicator 표시 여부를 선택합니다. 

 네트워크 설정  

애플리케이션과 연동할 서버를 추가, 삭제 합니다. 네트워크 그룹에서 추가하기 버튼을 

누르면 아래와 같은 대화상자가 나타납니다. 

    

그림 3-15 네트워크 설정 

▪ Type : 서버와 연결할 연결 Protocol을 선택합니다. 

▪ Name : 서버 이름을 입력합니다. 

▪ Path : 선택된 Protocol에 대해 생성된 Class 가 보여집니다. 

주의)  Network Class  AsyncHttpNetwork (http type)또는  AsyncSocketNetwork 

(TCP/IP type)을 상속받아 구현되어야 합니다. 

▪ Address : 서버 주소를 입력합니다. 

▪ Timeout : 서버와 연결 지연 제한 시간을 입력합니다. 

▪ Encoding : 문자 인코딩 방식을 입력합니다. 

▪ RESTful : HTTP를 선택한 경우 RESTful 사용 유무를 선택합니다. 

▪ Port : TCP/IP를 선택한 경우 연결 포트를 입력합니다. 

 리소스 업데이트 

리소스 업데이트 기능을 이용한 앱 배포일 경우(Target = doc)  리소스 업데이트 받을수 

있는 서버 정보를 설정합니다. 
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▪ Server : 네트워크 설정에서 추가한 서버 리스트 중 업데이트 서버를 선택합니다. 

▪ Tr code : 리소스 업데이트 서비스 코드를 설정합니다. Tr code는 업데이트 서버가 

서비스를 지원하는 형태에 따라 rest 방식과 interface.do 방식으로 구분됩니다. 

▪ Mode : 업데이트 서버가 갖고 있는 개발배포(dev), 운영배포(real)중 어떤 리소스를 

요청할 것인지를 선택합니다. 

 애플리케이션 

▪ Hardware Acceleration : 안드로이드 하드웨어 가속 기능 사용 유무를 선택합니다. 

▪ Theme : 안드로이드 Theme 사용 유무를 선택합니다. 

3.4.3. 라이브러리 매니저 

 

그림 3-16 라이브러리 매니저 

앱에 적용된 라이브러리들을 추가, 삭제, 업데이트 할 수 있습니다. 그림 3-16 의 왼쪽에 있는 

라이브러리 목록에서 라이브러리를 선택하면 오른쪽 설명 그룹에서 해당 라이브러리에 대한 정보 및 

상세 히스토리를 확인 할 수 있습니다. 

 코어 라이브러리 API : 리소스 매니저를 통해 최신의 코어 라이브러리를 받은 경우 이 

그룹에서 최신 코어 라이브러리를 앱에 적용할 수 있습니다. 최신의 코어라이브러리가 

확인된 경우 새 버전으로 업데이트하기 버튼이 활성화 됩니다. 

 애드온/플러그인 라이브러리 : 애드온/플러그인 라이브러리를 추가, 삭제, 업데이트할 수 

있습니다. 

주의) 라이브러리 / 플러그인을  선택 / 해제 후 반영을 위해 반드시 라이브러리 적용 

/적용해제 버튼을  선택해야 합니다. 
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3.4.4. Manifest.xml  

Manifest 탭과 라이브러리 매니저 탭 설정을 통해 생성되는 Manifest.xml 파일을 확인 할 수 

있습니다. 파일 포멧 유지를 위해 직접 수정은 제한됩니다. 
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3.5. 프로젝트 실행 

  모피어스 IDE 에서는 안드로이드, iOS, 브라우저 에뮬레이터를 통한 프로젝트 실행을 지원합니다. 

프로젝트를 실행하는 방법으로 Morpheus Application Manifest Editor를 이용하는 방법과 도구 상단 

Run 버튼을 이용하는 방법이 있습니다.  

 

• Morpheus Application Manifest Editor를 열고 실행 / 배포 그룹에서 원하는 실행 방법을 

선택합니다. 

 

그림 3-17 실행 메뉴 

• Project Explorer에서 실행하려는 모피어스 프로젝트를 선택하고 도구 상단 Run 메뉴 옆에 

세모 버튼을 누르면 그럼 아래 그림과 같이 드롭다운 메뉴가 나타납니다. 

 

그림 3-18 실행 메뉴(2) 

Run As메뉴에서 Morpheus Application for Android, Morpheus Application for Browser Emulator, 

Morpheus Application for iOS 메뉴 중 원하는 실행방법을 선택합니다. 

 

3.5.1. 안드로이드 디바이스 / 에뮬레이터에서 실행 

 안드로이드 디바이스로 실행 

안드로이드 디바이스가 PC에 연결된 상태에서 앱을 실행하면 그림 3-19 와 같은 안드로이드 

디바이스 선택 대화상자가 나타납니다. 
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그림 3-19 디바이스 선택 

연결한 안드로이드 디바이스를 선택하고 OK 버튼을 누르면 선택한 디바이스에 앱이 

설치되고 실행됩니다. 

 

 

 에뮬레이터로 실행 

앱을 에뮬레이터로 실행하기에 앞서 안드로이드 에뮬레이터를 생성해야 합니다. 도구 

상단에서 Android Virtual Device Manager 버튼을 클릭합니다. 
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그림 3-20 안드로이드 에뮬레이터 선택 

Android Virtual Device Manager(그림 3-20) 대화상자 중앙에는 설치된 안드로이드 

에뮬레이터 리스트가 나타나고 오른쪽에 있는 Create 버튼을 클릭하면 그림 3-21 과 같은 

새로운 안드로이드 에뮬레이터를 설정할 수 있는 대화상자가 나타납니다. 

 

그림 3-21 안드로이드 에뮬레이터 생성 
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▪ AVD Name : 생성하려는 안드로이드 에뮬레이터 이름을 입력합니다. 

▪ Device : 타겟 디바이스를 선택합니다. 

▪ Target : 안드로이드 OS 버전을 선택합니다. 

▪ CPU/ABI : CPU 종류를 선택합니다. 

▪ Keyboard : PC 키보드를 에뮬레이터에서 사용할지 선택합니다. 

▪ Skin : 선택한 OS에서 지원하는 하면 사이즈를 선택합니다. 

▪ Front Camera : 전면  카메라를 선택합니다. 

▪ Back Camera : 후면 카메라를 선택합니다. 

▪ Memory Options : 메모리 용량을 설정합니다. 

▪ Internal Storage : 에뮬레이터 저장공간 용량을 설정합니다. 

▪ SD Card : SD 카드를 생성하거나 이미지 파일이 있는경우 설정할 수 있습니다. 

▪ Emulation Options : 기타 안드로이드 에뮬레이터에서 지원하는 옵션을 선택합니다. 

 

모든 설정이 끝났으면 Finish 버튼을 눌러 안드로이드 에뮬레이터를 생성합니다. 

에뮬레이터 생성이 완료 된 후 다시 앱을 안드로이드로 실행 하면 안드로이드 에뮬레이터를 

통해서 앱이 실행됩니다. 

.  

 

 

3.5.2. 아이폰 디바이스 / 시뮬레이터에서 실행 

앱을 iOS 실행하기를 선택하면 그림 3-22 와 같은 iOS 애플리케이션으로 실행하기 대화 상자가 

나타납니다. 
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그림 3-22 iOS 실행 

 시뮬레이터로 실행하기 

iOS 애플리케이션으로 실행하기 대화상자에서 iPhone / ipad 시뮬레이터로 실행하기를 

선택하고 시뮬레이터 정보를 설정합니다. 

▪ SDK Version : 실행하려는 iOS 버전을 선택합니다. 

▪ Device Family : iPhone / ipad를 선택합니다. 

▪ Retina Display로 실행하기를 선택합니다. 

설정을 마친 후 OK 버튼을 누르면 시뮬레이터가 실행되고 앱이 실행됩니다. 

 

 디바이스로 실행하기 

iPhone 디바이스가 연결하고 iOS 애플리케이션으로 실행하기 대화상자에서 iPhone / ipad 

디바이스로 실행하기를 선택합니다. 디바이스 목록에서 앱을 실행할 디바이스를 선택한 후 

OK 버튼을 누릅니다. 

 

3.5.3. 브라우저 에뮬레이터에서 실행 

Browser Emulator 는 UI / Script 를 PC 환경에서 빠르고 편리하게, 개발 / 디버깅 할 수 있도록 편의 

기능을 제공하기 위한 툴입니다. Browser Emulator 실행 시 크롬 브라우저에서 Ajax 통신을 위해 보안 

설정을 해제하고 실행되어야 합니다. 브라우저 에뮬레이터로 실행하기를 선택하면 그림 3-23 과 같이 

브라우저 에뮬레이터를 선택하는 대화상자가 나오게 됩니다. 
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그림 3-23 브라우저 에뮬레이터 실행 

브라우저 에뮬레이터를 선택하고 OK 버튼을 누르면 실행중인 크롬 브라우저는 종료 강제 종료 후 

재실행 됩니다. 브라우저 에뮬레이터에서는 로컬 웹 서버를 통해 실행되므로 수정되는 화면을 

실시간으로 확인할 수 있습니다. 

주의) Browser Emulator 는 Direct View 가 사용 안함으로 선택되어 있어야 합니다. 

 

 

 

3.6. 프로젝트 배포하기 

모피어스 IDE 에서는 안드로이드 APK, iOS IPA, 프로젝트 압축, 리소스 배포를 지원합니다. 

프로젝트를 배포하는 방법으로 Morpheus Application Manifest Editor를 이용하는 방법과 Export 

메뉴를 이용하는 방법이 있습니다.  

 

 Morpheus Application Manifest Editor를 열고 배포하기 그룹에서 원하는 배포 방법을 

선택합니다. 

 

그림 3-24 배포하기 

 상단 메뉴 중 File → Export를 선택하면 그림 3-25 와 같은 Export 대화상자가 나타납니다.  

Morpheus트리를 열고 원하는 배포 방법을 선택합니다. 
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그림 3-25 Export 

3.6.1. 안드로이드 패키지로 배포하기 

안드로이드 패키지로 배포하기를 선택하면 그림 3-26 과 같이 Android APK Export Wizard가 

실행됩니다. Wizard 왼쪽에서 내보내려는 프로젝트를 선택하면 오른쪽에 선택한 프로젝트가 가지고 

있는 리소스들이 나타납니다. 프로젝트 선택 초기에는 모든 리소스들이 선택되어 있고 마우스 클릭을 

통해 선택을 해제할 수 있습니다. 해제된 리소스들은 패키지에 포함되지 않게 되므로 리소스 업데이트 

기능을 사용시 이용할 수 있습니다. 

 

주의) 반드시 포함되어야 할 항목 

Manifest.xml, mcore.mobile.lic, mcore.min.js, wninterface.js와 리소스 최초 업데이트와 관련된 

기본 파일 

 

 

36/60 



Morpheus Developer Guide ｜ Client 2.0 IDE   

 

 

그림 3-26 안드로이드 APK 배포(1) 

리소스 파일 선택의 편의성을 제공하기 위해 필터 기능을 제공하고 있습니다. 필터 옵션 버튼을 

누르면 그림 3-27 과 같은 화면이 나타납니다. 
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그림 3-27 파일 필터 

필터기능에는 파일 확장자, 파일 이름, 수정 기간, 결과내 재검색, 대소문자 구분등의 필터 기능을 

제공하고 있습니다.  

 파일 확장자 선택 : 선택된 확장자 파일만 선택합니다. 만약 선택하려는 확장자가 리스트에 

없을 경우 Other extensions 항목에 입력하시면 됩니다. 이때 입력 형식은 *.확장자 

이름이 되어야 합니다.  

 파일 이름 : 파일 이름으로 검색할 경우 검색하려는 이름을 입력합니다. “*” 문자를 이용해 

시작 문자열,  끝나는 문자열 검색도 가능합니다.(ex) NewFile*, *system) 

 기간 : 파일의 수정 날짜로 검색합니다. 

 결과 내 재검색 : 현재 선택되어있는 파일들을 재 검색합니다. 

 대소문자 구분 : 파일 이름의 대소문자를 구분해서 검색합니다. 

필터 옵션을 모두 선택하고 OK 버튼을 누르면 선택된 필터 기능들이 AND 연산되어 파일을 

선택합니다. 리소스 파일 선택을 하고 Next 버튼을 눌러 다음 단계로 이동합니다. 
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그림 3-28 안드로이드 APK 배포(2) 

이번 단계는 배포되는 앱에 서명을 위한 Keystore 선택 페이지 입니다. 이미 생성해 놓은 Keystore가 

있다면 Location의 Browse 버튼을 눌러  Keystore 파일을 선택하고 설정된 비밀번호를 입력합니다. 

만약 생성된 Keystore가 없다면 Create new keystore를 선택하고 Location의 Browse 버튼을 눌러 

새로운 Keystore를 저장할 경로와 이름을 입력합니다. 파일을 입력하였으면  Keystore 비밀번호와 

비밀번호 확인을 위해 Confirm에 다시 한번 입력합니다. Keystore선택 혹은 생성 설정이 완료 되면 

Next 버튼을 눌러 다음단계로 넘어갑니다. 

 이미 생성되어 있는  Keystore를 선택한 경우 
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그림 3-29 안드로이드 APK 배포(3) 

Alias 목록을 누르면 Keystore에 등록되어있는 Alias가 나타납니다. 서명하려는 Alias 를 선택하고 

올바른 비밀번호를 입력한 후 Next 버튼을 눌러 다음단계로 넘어갑니다. 만약 새로운 Alias를 

생성하려면 Create new key를 선택하고 Next 버튼을 누르면 아래 Keystore 생성을 선택한 경우와 

같은 단계를 진행하게 됩니다. 

 

 Keystore 생성을 선택한 경우 
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그림 3-30 안드로이드 APK 배포(4) 

Alias를 생성하는 페이지가 나타납니다. 

 Alias : Alias을 입력합니다. 

 Password : Alias 비밀번호를 입력합니다. 

 Confirm : Alias 비밀번호 확인을 위해 위에서 입력한 비밀번호를 다시 한번 입력합니다. 

 Validity : 생성하는 Alias의 유효기간을 숫자로 입력합니다.  

 First and Last Name : 개발자 이름을 입력합니다. 

위 5 개 항목을 입력하면 Next 버튼이 활성화 되고 다음 단계로 넘어갈 수 있습니다. Next 버튼을 

눌러 다음 단계로 넘어갑니다. 
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그림 3-31 안드로이드 APK 배포(5) 

배포 파일의 경로를 설정합니다. Destination APK file의 Browse 버튼을 눌러 경로를 선택하고 배포 

파일의 이름을 입력합니다. 여기까지 모든 설정을 했으면 Finish 버튼이 활성화 됩니다. Finish 버튼을 

누르면 선택한 경로에 안드로이드 배포 파일이 생성됩니다. 

 

3.6.2. iOS 패키지로 배포하기 

iOS 패키지로 배포하기를 선택하면 그림 3-32 와 같이 iOS IPA Export Wizard가 실행됩니다. Wizard 

왼쪽에서 내보내려는 프로젝트를 선택하면 오른쪽에 선택한 프로젝트가 가지고 있는 리소스들이 

나타납니다. 리소스 선택 및 필터 적용법은 안드로이드 패키지 배포하기에서 설명한 내용과 동일합니다. 
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그림 3-32 iOS IPA 배포(1) 

파일 경로의 Browser 버튼을 눌러 IPA 파일이 배포될 경로와 파일 이름을 입력한 후 Next 버튼을 

눌러 다음 단계로 넘어갑니다. 
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그림 3-33 iOS IPA 배포(2) 

그림 3-33 에서는 빌드 하려는 iOS SDK 버전과 사인하려는 개발자 인증서를 선택합니다. IOS 개발자 

인증서는 iOS Provisioning Portal 을 통해 생성하여 PC에 저장되어 있어야 리스트에 나오게 됩니다. 

모든 설정을 마치고 Finish 버튼을 누르면 설정한 경로에 ipa 파일이 생성됩니다. 

 

 

 

44/60 

https://developer.apple.com/ios/manage/overview/index.action


Morpheus Developer Guide ｜ Client 2.0 IDE   

 

3.6.3. 프로젝트를 압축파일로 배포하기 

 

그림 3-34 압축파일 배포 

프로젝트에서 찾기... 버튼을 눌러 zip파일로 내보내려는 프로젝트를 선택합니다. 프로젝트가 선택되면 

프로젝트 정보에 프로젝트 이름 및 프로젝트에 적용된 라이브러리 정보가 나타납니다. 대상파일의 

찾기... 버튼을 눌러 내보내려는 파일의 경로와 파일명을 입력합니다. 모든 설정 완료 후 Finish 버튼을 

누르면 선택한 경로에 zip 형식으로 압축된 파일이 생성됩니다. 
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3.6.4. 리소스 배포하기 

 

그림 3-35 리소스 배포 

본 기능은 리소스 업데이트 기능을 사용하여 업데이트를 지원하는 앱이 리소스 업데이트가 있을 경우 

서버에 등록하기 위한 리소스 파일을 배포하기 위한 기능 입니다. 그림 3-35 위자드의 왼쪽에서 

프로젝트를 선택하고 오른쪽에서 배포하려는 리소스 파일을 선택합니다. 파일 필터 기능은 안드로이드 

내보내기의 기능과 동일합니다. 파일경로에 내보내려는 파일 경로를 선택하고 Finish 버튼을 누르면 

설정한 경로에 리소스 업데이트 서버에 올릴 수 있는 압축 파일이 생성됩니다. 

 

 

3.7. 프로젝트 가져오기 

모피어스 IDE 에서는 디텍터리 구조, 압축파일의 프로젝트 가져오기를 지원합니다. 상단 메뉴 중 File 

→ Import 를 선택하면 그림 3-36 과 같은 Import 대화상자가 나타납니다.  
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그림 3-36 Import 

Morpheus 트리를 열고 Import Morpheus Application Project를 선택하고 Next 버튼을 누릅니다. 
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그림 3-37 프로젝트 가져오기 

 

 Select root directory : 가져오려는 프로젝트가 폴더구조로 존재하는 경우 이곳에 경로를 

입력합니다. 

 Select archive file : 가져오려는 프로젝트가 압축파일일 경우 이곳에 경로를 입력합니다. 

 Projects : 선택된 경로에 있는 모피어스 프로젝트가 나열됩니다. 가져오려는 프로젝트를 선택할 

수 있습니다. 

 Search for nested projects : 중첩된 프로젝트가 존재하는지 검사합니다. 

 Copy Projects into workspace : Workspace로 프로젝트 파일을 복사합니다. 

 Working sets : 생성되어있는 워킹셋에 프로젝트를 추가합니다. 

가져오려는 프로젝트를 선택하고 Finish 버튼을 누르면 프로젝트를 Project Explorer에서 확인 할 수 

있습니다. 

 

3.8. Browser Emulator 

Browser Emulator 는 UI / Script 를 PC 환경에서 빠르고 편리하게, 개발 / 디버깅 할 수 있도록 편의 

기능을 제공하기 위한 툴입니다. 그림 3-38 은 브라우저 에뮬레이터를 통해 실행된 샘플 앱 화면 

입니다. 
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그림 3-38 Browser Emulator (1) 

 

•  를 선택하면  Device 에 따른 해상도 변경 및  가로, 세로 화면 전환을 통한 

시뮬레이션이 가능합니다. 
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그림 3-39 Browser Emulator (2) 

직접 입력을 통해서도 해상도를 변경할 수 있고 그 아래 제조사 별 디바이스 선택을 통해서도 해상도 

변경이 가능합니다. 

•  는 현재 화면을 고정시켜 디버깅 및 개발을 하는데 용이하게 사용할 수 있습니다. 

• 는 전체화면으로 전환이 가능합니다. 기존 화면으로 복귀 시에는 ESC 키를 눌러 복원할 

수 있습니다. 

• 는 뒤로가기 버튼으로 활용됩니다. 

• 는 화면 갱신 시 활용됩니다 

• 는 모바일 웹 표준 및 장애인 차별 금지법 준수여부 체크를 위한 메뉴 입니다. 
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그림 3-40 Browser Emulator (3) 

그림 3-40 의 오른쪽 영역의 붉은 표시 항목이 미 준수 항목으로 요소 체크가 가능합니다. 
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3.9. IDE 환경 설정 

IDE 환경 설정을 하기 위해서는 그림 3-41 과 같이 환경설정 메뉴를 선택합니다. 

 

그림 3-41 환경설정 메뉴 

 Mac : Morpheus → 환경설정 

 Window : Window → Preference  

 

메뉴를 선택하면 환경설정 다이얼로그가 실행된다. 왼쪽 메뉴에 Morpheus 트리를 선택 하면 

Morpheus , License, Local WebServer 3 개의 환경 설정 페이지를 확인 할 수 가 있습니다. 

 

 Morpheus 

 

그림 3-42 기본 환경설정 
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IDE 실행에 필요한 기본 설정을 합니다.  

 Morpheus IDE 환경설정 : JDK 경로 및 안드로이드 파일 경로, ADB 파일 경로등을 확인 

및 변경할 수 있습니다. IDE 최초 실행시 자동 설정 됩니다. 잘못된 경로가 입력되면 IDE 

기능에 문제가 생길 수 있기 때문에 올바른 경로를 입력해 줘야 합니다.  

 Morpheus IDE 업데이트 : IDE 자동 업데이트 검사 체크가 되어 있으면 IDE 실행 시 

업데이트 상태를 체크하여 업그레이드 항목이 있을 경우, 업그레이드를 수행하게 됩니다. 

 License 

 

그림 3-43 라이선스 설정 

라이선스를 관리하는 페이지 입니다. 

 추가하기 : 라이선스를 추가 합니다. 추가된 라이선스는 프로젝트 생성할 때와 생성된 

프로젝트 라이선스 변경할 때 사용 됩니다. 

 삭제하기 : IDE에 설치된 라이선스를 삭제합니다. 

 Local WebServer 
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그림 3-44 로컬 웹서버 설정 

다이렉트 뷰 기능에서 사용하는 로컬 웹서버에 대한 설정입니다.  

 Port : 웹서버 포트를 설정합니다. 

 Host Name : 호스트 이름을 설정합니다. 

 Session timeout : 클라이언트의 세션 타임아웃 시간을 설정합니다. 단위는 분입니다. 

 URL Routing :  

 

 

3.10. IDE 정보 확인 

IDE 환경 설정을 하기 위해서는 그림 3-45 와 같이 환경설정 메뉴를 선택합니다. 

 

그림 3-45 정보확인 메뉴 

 Mac : Morpheus → Morpheus에 관하여 

 Window : Help → About Morpheus 
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그림 3-46 과 같은 화면에서 IDE 에 대한 상세 정보를 확인 할 수 있습니다. 

 

 

그림 3-46 IDE 정보확인 

하단에 모피어스 아이콘 을 누르면 모피어스 플러그인 상세 정보를 확인할 수 있는 대화상자가 

나타납니다. 

 

그림 3-47 플러그인 정보확인 
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그림 3-47 의 리스트에서 플러그인을 선택하면 플러그인 버전과 라이선스를 확인할 수 있습니다. 
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3.11. IDE 업데이트 

   IDE 기능 업데이트나 버그 패치 후에는 플러그인 업데이트를 진행해야 합니다.  

 

그림 3-48 업데이트 메뉴 

보통은 IDE 재시작 시 플러그인 버전 확인을 통해 업데이트 여부를 묻지만 이때 업데이트 수락을 

하지 못한 경우 그림 3-48 과 같이 Help → Check for Updates 메뉴에서 업데이트 여부를 확인할 수 

있습니다 

수동으로 플러그인을 설치하거나 업데이트해야 하는 경우에는 Help → Install New Software 메뉴를 

이용할 수 있습니다.  Install New Software 메뉴를 선택하면 그림 3-49 와 같은 Install 대화상자가 

실행됩니다. 
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그림 3-49 플러그인 선택 

Work with에  http://docs.morpheus.kr/ide/morpheus 를 입력하면 새로 설치하거나 업데이트 

받아야 하는 리스트가 나오게 됩니다. Morpheus Mobile 항목을 선택하고 Next 버튼을 누릅니다. 
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그림 3-50 플러그인 버전 확인 

설치하려는 플러그인에 대한 정보를 확인 하고 Next 버튼을 누릅니다. 

 

그림 3-51 라이선스 확인 

라이선스를 확인하고 라이선스에 동의하게 되면 Finish 버튼이 활성화 됩니다. Finish 버튼을 누르면 
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플러그인 설치가 진행되고 설치가 완료 후 새로 받은 플러그인 적용을 위해 IDE가 재 시작 됩니다. 

 

3.12. 공지 사항 

 모피어스 IDE를 시작하면 공지 그림 3-52 와 같은 공지사항을 확인하실 수 있습니다.  

 

그림 3-52 공지 사항 

공지사항을 통해 업데이트 내역 및 최신 이슈를 사용자에게 빠르게 전달해 드립니다. 이미 확인한 

공지라면 공지사항 대화상자 하단의 ‘이 공지 다시 보지 않기’를 선택하시면 해당 공지 내용이 다음 

시작할 때부터 안보이게 됩니다. 

 

그림 3-53 공지사항 보기 메뉴 

 전체 공지 리스트를 확인하려면 도구 상단 메뉴 중 Help -> Open notice를 누르시면 웹 브라우저를 

통해 공지사항 리스트가 나오게 됩니다. 
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